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Lithology Digitizing 

1- Create well header:  

-In the main window make sure that you are in Litho Mode  

 

-From File Menu select “New/select Well”, it will open the following window: 

 
 

- Click “New well” Button to begin registering new well header. 

- Fill the Fields with the corresponding header data and click “Log Image..” button to select 

the log image file that will be copied to the application directory. (IMAGE folder) 

- Click “Insert Well” button. 

- At left side of the newly created well ; there will be 3 letter that denotes to : 

    1st  position  “L “ means the well has Lithology calibration data; if not it will display ”_”  

    2nd position “C”  means the well has curve calibration data; if not it will display ”_” 

    3rd position  “D”  means the well has dipmeter calibration data; if not it will display ”_” 

        

- Finally click “Ok..I selected a well” button. 

- Wait a minute or a couple of minutes to finish splicing process for the image that takes 

place one time at first open for the well log image. 

 

Notes: 

- Two Fields are Mandatory for inserts (Well name & Log image). 

- You can amend well header data by just retype the new values in fields. 

- If you want to delete any well header, just select its name from the list of “Current 

Wells” and click “Delete Well” Button that will delete the well with its all related data 

files & image for Lithology data, Curves data and Dipmeter Data. 

- From current wells drop list you can filter to find a specific well name. 

- From time to time don’t forget to click “Empty slices” to free space your disk. 



DigiLogs 2 www.digilogs.net 

2- Calibration Lithology Track: 

- First adjust the appropriate zoom level by clicking the (+) or (-) buttons on top right of 

the image. (Note:  beginning the calibration process it will preserve that zoom level 

along the entire digitizing process). 

- Type the beginning depth interval in the top box and click “Calibrate” button; then click 

in the image at top depth. (Note: to handle image distortion like stretching & wave 

tilting that results from poor scanning; you prefer to calibrate multiple intervals and 

calibrate multiple internal calibrations within the main calibrated interval). 

- You can navigate to next image slice by pressing “Page down” on the keyboard or “Page 

down” to navigate to previous image slice. 

 

 

-Type the bottom depth then Click “Calibrate” button; then click in the image at bottom depth. 
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The horizontal depth grids will appear at one to verify that the red calculated grid are exactly 

overlays the image grids. If there any shift; you can calibrate internal calibrations as much as you 

need to justify the grids exactly before begin the digitizing process. It can be done by typing the 

required depth in depth box and click “Internal Cali.” Button then click in the image at the 

corresponding depth. 

-if you want to change the grid interval or label/Bolding interval; click “Show Grids”  

 Then make your changes by selecting the appropriate depth or 

typing it directly if it’s not available ; also select bolding frequency 

(that will label depth on the bolded grid lines) then click “Ok”. 

 

 

3- Picking Lithological Layers: 

- Begin to pick by mouse click at the first layer bottom , a lithology pallet picker will pop 

up aligned to that layer bottom to select the corresponding rock type , then pick the 

next layer bottom and so on.. 

-  
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-  

- If you want to add custom lithology , from “Edit” menu select “Lithologies Codes” 

- Type in the empty field your new lithology and click “Add” button and when finished 

click “Save” button. 

 

- You can amend any value by retype the new values then click “Save”. 

- You can delete any record by right click on the record header then select “Delete 

Lithology” ; except the standard lithology classes. 

- You can pick your custom lithologies from the little arrow appears in bottom right the 

lithology pallet picker . 
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- When you reach the last layer which located just above the lower red calibration 

border, all you have to do is press button “Finish Interval” or  letter “F” on the keyboard 

or by click lower than that red line , a confirmation message will pop up to make sure 

that want to extend last layer to the end of calibration zone.. click Yes button then pick 

the last rock unit.(At this point auto save of your lithology pickings takes place)  

- Type the next interval bottom depth value in the bottom box field and click calibrate 

button then begin picking layers and so on until finishing the entire log image. 

4- Exporting ASCII data: 

To export the digitized lithology ; first make sure you finished the ongoing digitizing or editing mode. 

From file menu select “Export Ascii”  then browse where you want to export the ascii data (CSV file 

output). Two files will be exported one with lithologies codes and the other with lithologies class 

names. 

 

5-Lithology Edit mode: 

Any digitizing mistakes can be fixed later by Edit Mode. From Edit menu select “Edit Mode” or just 

press keyboard shortcut “E”. 

First select the calibrated interval which have to be edited by click on the row header in the 

calibrations list or by just click on the image log at the desired interval. All the editing tools will be 

enabled upon activating any calibration. 
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A- Edit picks: 

You can edit the picked lithology by selecting it first either by click on it in the image or click the row 

header of the required pick in the pickings table. The selected pick will be colored by your preset 

digitizing line color and will be selected in the pickings table.  
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- You can then shift the pick up and down by catching the selected pick by click then drop it in the 

new location. You can delete the selected pick by pressing “Delete key” from the keyboard. 

-If you want to pick a missed lithology; just click in the desired location and pick your lithology. 

-If you want to change existing lithology type preserving its location; double click on its record 

header that will launch the lithology pallet picker; then select the right lithology type. 

B- Edit calibrations data: 

-You can edit the top, Bottom values by just retyping it in the calibration table.  

-You can re-position any of calibration borders by click “Top Border” button to recalibrate the top 

border or click “Bottom Border” to recalibrate the bottom border then point it on the image. 

-You can insert a new calibration between any calibration gaps by selecting the below interval and 

right click on the calibration row header and select “Insert Calibration Above” from the calibration 

context menu. It will fill the gap by a new calibration. If you activate the first calibration to insert a 

new calibration above; it will put top border line above the selected interval by 100 pixel and assign 

initial top depth value by subtracting 25 depth unit from the upper most top depth then re-assign 

the desired values to the newly added calibration. 

-You can truncate a calibrated interval from all its picks by select “Truncate points” from the 

calibration context menu. 
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-You can delete any calibration along with its picks by select “Delete calibration” from the calibration 

context menu. 

After finishing your edits; click “Save Edit” button to apply your changes. If you don’t want to save; 

click “Cancel” button. 
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Curve Digitizing: 

1- Create well header:  

-In the main window make sure that you are in Curve Mode  

-From File Menu select “New/select Well” , it will open the following window: 

 

 
 

- Click “New well” Button to begin registering new well header. 

- Fill the Fields with the corresponding header data and click “Log Image..” button to select 

the log image file that will be copied to the application directory. (IMAGE folder) 

- Click “Insert Well” button. 

- Now you can add a new curve to that well.. Click on your new well name to activate it as 

current well then click “New Curve” button. 

-Fill the empty fields with the corresponding curve header. If you want to digitize logarithmic 

scale curve then check the box “Log Scale?”  otherwise  leave it unchecked if it’s linear scale. 

If you have step block curve (like ROP curve) then check the box “Rectangular Step?”. 

-Click “Insert Curve” button. 

-Click on the curve name you have just inserted to activate it as your current curve then click 

“Ok..I selected well and curve” button. 

 

 Notes: 

-Well header is used in Lithology , Curve and Dipmeter digitizing Modules so that you have to create 

it just one time for any modes. 

-The only mandatory field in curve header is the curve name. 

- You can amend curve header data by just retype the new values in fields. 

- If you want to delete any curve  header just select its name from the list of “Current Curves” and 

click “Delete Curve” Button. 
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2- Calibration Curve Track: 

- First adjust the appropriate zoom level by clicking the (+) or (-) buttons on top right of 

the image.(Note:  beginning the calibration process it will preserve that zoom level 

along the entire digitizing process). 

- You will take 4 calibration points for each calibration zone . (Note: to handle image 

distortion like stretching & tilting that results from poor scanning ; you prefer to 

calibrate multiple intervals each of which you can calibrate internal calibration for fine 

tuning).  

- Type the beginning depth interval in the top box (Mini. Depth) and type minimum scale 

value in the bottom box (Mini. Scale) if you didn’t type it during entering well details 

form ; then click “Calibrate 1”. 

- Click on the image in corresponding position to the mini depth and mini scale values 

like following: 
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- Type the beginning depth interval in the top box (Mini. Depth) and type maximum scale 

value in the bottom box (Maxi. Scale) then click “Calibrate 2”. 

- Click on the image in corresponding position to the mini depth and maxi scale values 

like following: 
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- Type the stop depth interval in the top box (Maxi. Depth) then click “Calibrate 3”. 

- Click on the image in corresponding position to the maxi depth and mini scale values 

like following: 
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- Now click “Calibrate 4” or just press space bar and click on the image in corresponding 

position to the maxi depth and maxi scale values like following: 

 

 
 

 

Note: if you have curve reads from right to left, take your calibration points normally as 

described where first calibration point which refer to min. depth & min scale will be top 

right corner then the second one will be top left corner and so on .. 

 

Internal Calibration Option: 

After calibrating the 4th corner; Both vertical and horizontal grids will be shown once at once to 

enable you observe any shift in depth (vertical component) or scale shift (horizontal component). 

You can correct this shift by adding as much as you need internal calibration points.  

 

 

To add point; type the required depth and click button “Internal Cali. 1” and click by the cursor on 

that depth on image at the minimum scale axis; then click button “Internal Cali. 2” and click by the 

cursor on the same depth but at the maximum scale axis. The adjustments will be displayed at 

once. 
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To modify the grid display parameters; click on button “Show Grids”  

Then make your changes by selecting the appropriate depth and scale interval or 

typing it directly if it’s not available then click “Ok”. 

 

 

 

 

 

 

 

Notes: 

1- Depth labels will be displayed on the bolded lines. 

2- No Scale Grid options available for logarithmic, Internal or Dipmeter Grids. 
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Internal Grids Option: 

In some logs there are odd cases of scales; either non-equidistant sequential scale or non-

sequential linear scale like illustrated: 

                            

 

 

  

 

 

 

 

 

 

 

 

To solve this problem, you have to calibrate all scale grids just for the first calibrated interval then 

it will be continued to the next intervals.  To do this, type scale value in the grid box then click 

calibrate button then click by the cursor at that grid value on the image at the top red border line. 

Repeat that steps grid by grid until the last grid line. If you want to remove the last grid 

calibration; click “Clear grid” button. 

Notes:  

1- you can begin calibrating internal grids once you calibrated the 4th 

corner point and during digitizing mode. 

            2- This option is also available in Dipmeter Mode. 

            3- Before beginning the digitizing, it’s preferred to hide the grid 

(both the vertical and horizontal) by uncheck the show grids checkbox to clear the vision of the 

curves. 

 

Non-equidistant sequential scale Non-sequential linear scale 
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3- Picking (Tracing) The Curve: 

- Begin to click on the desired curve to trace it along all the calibrated zone. 

- If you pick wrong position you can re-pick it by just clicking upper the wrong pick or 

press “Delete” key in the keyboard to delete the last pick. 

- If you have a gape in the curve, click “Split” Button when reaching that gape. 

Backup Options: 

If you clicked after the red calibration border in extension to last curve segment, a message box will 

pop up with three options: 

 
1- Backup mode: the curve will be wrapped from the opposite side inside the track. When 

finishing the backup segment; just get with the cursor out the calibrated rectangle and it will 

be returned to normal scale.. 

2- Over-Scale mode:  If you want to pick curve off-scale outer the track, pick the off-scale 

segment until getting back inside the track that will de-activate the off-scale mode. 

3- Stop at border Mode: If you want to trim the curve just to stop the curve at the track border, 

the curve will be trimmed and spitted. 

Notes:  

- You can backup up to twice wrappings only (backup of backup). 

-The same mechanism applied for backup & off-scale at minimum scale limit. 

- If the curve maintain the same behavior, check “Remember my choice next time for this curve 

during this session” so that you will not be asked again. 

- If you want to toggle on/off cursor tracing; press keyboard key “T”. 
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4- Finishing the Curve: 

When picking reach the lower calibration boundary and your current curve still extends to lower 

intervals , just pick lower the lower red calibration border so that last picking point will be placed in 

the intersection between the lower red calibration line and your last extended line and the following 

message box will pop up: 

 
 

 

 

1 – If you want to move to the next interval in the same track, click the first option icon.   

2 – If you want to select another curve to digitize in the same interval with the current calibration, 

click the second option icon.  Well Details window will be opened to select another curve. 

 

Notes: 

- In any time during picking you can finish the curve making a discontinuity with the next 

interval (intended gap) 

- If you have added internal grids, it will be maintained to the other curve that you will 

select by using the second option. 
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Show Other Curves: 

If the track includes two or more curves; you may be confused by curves crossings and may trace the 

wrong curve. So it’s preferred to show your finished curves by clicking “Show Curves” button; the 

following window will pop-up: 

  

Select line colour and line style type then click the right pointed arrow so that it will save your 

preferences for that well forever. If you have assigned curve preferences for that curve name for any 

previous well ; it will capture the last  preferences for that curve. The right side curve list contains 

the curves that will be displayed in the log while the left side curves are not displayed as you didn’t 

assign properties yet for them. You can change your preferences any time from the right side 

controls and even can remove the preferences of any curve by selecting that curve from the right 

side and click the left pointed arrow.  
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Scale Multiplier: 

Some old logs uses scale multiplier like illustrated. Just toggle the appropriate multiplier factor (X10 

or X100 or X2 or X5 or if none of previous common cases; type the multiply factor in the multiplier 

box. to return the normal multiplier; switch to X1. 

 

 

 

 

 

 

 

 

 

 

 

Notes: 

-Line style will be changes automatically when switching to different multiplier to differentiate easily 

between the multipliers. (Solid line  X1, dotted line  X10, dashed line  X100 or any other 

multiplier factor). 

-Switching multiplier will auto-split curve on display but it will be interpolated in export calculation 

as long as the gap between multipliers not exceed 2 depth units. 

 

5-  Auto-Tracing The Curve: 

- Toggle On/Off Auto-Trace mode by pressing "Ctrl" keyboard botton or by click "Auto Trace" status 

bar botton  ; that will highlight its label to green when activated.  

- Begin to click on the desired curve to trace it automatically along all the calibrated zone.  

- If miss-tracing happened; you can re-pick it by just clicking upper the wrong tracing segment then 

press letter "S" to merge that correction with the rest of the tracing, also toggle off Auto Trace mode 

while correcting the Auto-Traced segment will merge it with the same way. 

In this example: make the original 

scale from 0-20 then use multipliers 

X10 to trace the 0-200 segments 

and use X100 to trace 0-2000 

segments. 
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- Auto Tracing will stop upon either failing to continue catch the curve mid line or if it reach too close 

to the calibration borders (right, left or bottom border). 

Backup Options: 

Auto tracing can't exceed borders limit so you have to toggle it off and get into backup mode 

manually then Toggle on and continue Auto Tracing on the backup segment until its end then return 

it manually to normal scale by the same way. 

Finishing Curve in Auto Trace Mode: 

- You can click Finish button , or Toggle auto trace off and manually finish the curve by click below 

the bottom calibration border. 
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6- Exporting LAS: 

At first make sure you finished the ongoing digitizing or Edit mode. From file select “Export 

LAS”.  the following window will pop up:  

1-  Select the desired well  

2-  Select a curve or multi-select between the available 

curves. You can select all curves by right click on the 

curves list; a context menu will pop-up; click “Select 

All Curves”. 

3- You can type a specific depth range or leave it empty 

to take the entire available depth range. 

4- Select the desired step value. 

5- Click “Export Curves” Button. Browse where you want to export the file. After exporting 

the las; it reports the total footage digitized for your statistics. 

6- If you check “Discrete Points” it will export only your points as depth versus curve value 

without interpolations in between; so you have to export curve by curve. 

Curve Edit mode: 

Any digitizing mistakes can be fixed later by Edit Mode. From Edit menu select “Edit Mode” or just 

press keyboard shortcut “E”. 
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First select the calibrated interval which have to be edited by click on the row header in the 

calibrations list or by just click on the image log at the desired interval. All the editing tools will be 

enabled upon activating any calibration. 

C-  Editing the calibration data: 

You can edit the top, Bottom, minimum scale value or maximum scale value by just retyping it in the 

calibration table.  

You can re-position any of the four calibration points by click point number button of the required 

corner and then point it on the image. 

After finishing your edits; click “Save Edit” button to apply your changes. If you don’t want to save; 

click “Cancel” button. 

You can insert a new calibration between any calibration gaps by selecting the below interval and 

right click on the calibration row header and select “Insert Calibration Above” from the context 

menu. It will fill the gap by a new calibration. If you activate the first calibration to insert a new 

calibration above; it will put point 1 and 2 above the selected interval by 100 pixel and assign initial 

top depth value by subtracting 25 depth unit from the upper most top depth then re-assign the 

desired values to the newly added calibration. 
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D- Editing the curve drawing: 

Click the pencil tool icon and draw the correct curve trace then click “Save Edit” button. 

Note that it will overwrite the old drawing. You can split the curve to create a gap or erase 

unwanted curve segment by using the Split tool icon  and click on the image. 

If you click on the curve in between two vertices; it will split the curve in between and if you 

click on the vertex itself; it will delete that vertex and create a gap. 

Note: to visualize the vertices of the curve; from the calibration context menu select 

“Highlight Points”. 

If you want to erase all the vertices in the activated interval; from the calibration context 

menu select “Truncate Points”. 

If you want to delete the entire calibration along with its vertices; from the calibration 

context menu select “Delete Calibration”. 

E- Edit Internal Grids: 

You can add or edit the Internal Grids easily by activating the desired calibration and use the 

Internal Grids Controls. 
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If you want to apply Internal Grids edits to the selected calibration only, let the toggle option 

on “Apply to Selected Cali.” While if you want to apply on all calibrations; toggle on the 

second option “Apply to All Cali.” Then click “Save Edits” button. 
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Dipmeter Digitizing: 

1- Create well header:  

-In the main window make sure that you are in Dipmeter Mode  

-From File Menu select “New/select Well”, it will open the following window: 

 
 

- Click “New well” Button to begin registering new well header. 

- Fill the Fields with the corresponding header data and click “Log Image..” button to select 

the log image file that will be copied to the application directory. (IMAGE folder) 

- Click “Insert Well” button. 

- Finally click “Ok..I selected a well” button. 

Notes: 

- Two Fields are Mandatory for inserts (Well name & Log image). 

- You can amend well header data by just retype the new values in fields. 

- If you want to delete any well header just select its name from the list of “Current 

Wells” and click “Delete Well” Button that will delete the well with its all related data 

files & image for Lithology data, Curves data and Dipmeter Data. 

2- Calibration Dipmeter Track: 

The default scale for dipmeter is the tangential scale that ranges from 0 to 90 degree with 

left to right orientation; so you don’t need to define all that preset parameters. Though 

there are some dipmeter logs has been plotted with non-equidistant linear scale where you 

have to use the Internal Grids option to calibrate the scale correctly. 

  

  

Tangential Scale Non-equidistant Linear Scale 
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- Calibrate the four corner points as shown in curve digitizing mode. Once you calibrate 

the fourth corner point; the horizontal depth grids and the tangential vertical grids will 

be displayed. Use the internal calibration if needed and use the Internal Grids in case of 

non-equidistant sequential scale. 

 

3- Tracing Tadpoles: 

- Toggle on the required dip quality flag at first (1 Excellent, 2 Good, 3 Fair, and 4 Poor). 

The excellent dip quality will be filled automatically while all the other qualities will be 

hollow circles. 

- Click in the centre of the tadpole circle defining the depth and dip angle value then click 

at the end of the arrow of the tadpole defining the azimuth value. 

- Press delete key to remove the last tadpole entry. 

- Press the plus key (+) on the keyboard to increase the circles radius and the minus key 

(-) to decrease the circles radius. 

- To move tadpole circle or azimuth line; use keyboard letters “A”,”D”,”W”,”S” 

- After finishing the required tadpoles in the calibrated interval; click “Finish Interval” 

button to save and move to the next interval. 
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Dipmeter Edit Mode 

From Edit menu select “Edit Mode” or just press keyboard shortcut “E”. 

First, select the calibrated interval, which have to be edited by click on the row header in the 

calibrations list or by just click on the image log at the desired interval. All the editing tools will be 

enabled upon activating any calibration. 

A- Editing the calibration data: 

-You can edit the top, Bottom, minimum scale value or maximum scale value by just retyping it in the 

calibration table.  

-You can re-position any of the four calibration points by click point number button of the required 

corner and then point it on the image. 

-You can insert a new calibration between any calibration gaps or truncate calibration from all its 

tadpoles or delete the entire calibration along with all its tadpoles; from the calibration context 

menu as described previously in curve mode. 

-After finishing your edits; click “Save Edit” button to apply your changes. If you don’t want to save; 

click “Cancel” button. 
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B- Edit Tadpoles: 

Use tadpole pencil tool  to add new tadpole. Use delete tadpole tool  to remove tadpoles 

by clicking on the center of the tadpole circle.  

C- Edit Internal Grids: 

You can add or edit the Internal Grids easily by activating the desired calibration and use the 

Internal Grids Controls. 

If you want to apply Internal Grids edits to the selected calibration only, let the toggle option 

on “Apply to Selected Cali.” While if you want to apply on all calibrations; toggle on the 

second option “Apply to All Cali.” Then click “Save Edits” button. 

4- Exporting LAS: 

Open well log first then from file select “Export LAS”.  

Toggle the desired Quality format option (Numbers: 1,2,3,4 Or Letters: E,G,F,P) 

Toggle the desired File format (LAS: with well header Or ASCII: plain text file  

without well header. 

Then click “Export” button; Select destination and save. 


